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Preface

Welcome to Oracle Forms Developer! This document will help you get started with 
Forms Developer for Windows.

Prerequisites
You should be familiar with your computer and its operating system. For example, 
you should know the commands for deleting and copying files and understand the 
concepts of search paths, subdirectories, and path names. Refer to your Microsoft 
Windows product documentation for more information.

You should also understand the fundamentals of Microsoft Windows, such as the 
elements of an application window. You should also be familiar with such pro-
grams as the Explorer, Taskbar or Task Manager, and Registry.

Notational Conventions
The following typographical conventions are used in this guide:

Convention Meaning

fixed-width font Text in a fixed-width font indicates commands that you enter 
exactly as shown. Text typed on a PC is not case-sensitive unless 
otherwise noted.

In commands, punctuation other than brackets ( [  ] ) and verti-
cal bars ( | ) must be entered exactly as shown.

lowercase Lowercase characters in a command statement represent a vari-
able. Substitute an appropriate value.

UPPERCASE Uppercase characters within the text represent command names, 
SQL reserved words, and keywords.



Related Publications for Installation
Before using this manual and installing the product, you should read the Release 
Notes.  The Release Notes (included as a file on the product CD) provide late-break-
ing information that may be relevant to the installation process.  

If you will be deploying your completed applications on the web, then you must 
also install the Forms Server.  (Forms Server is licensed separately; a free 30-day 
trial is available.)  The server installation is an additional step after you complete 
the instructions in this Getting Started manual.  That additional step is described in 
the manual Oracle Forms Developer: Deploying Forms Applications to the Web with Oracle Forms 
Server, A73071.

Also included on the CD are the Oracle Reports Developer and Oracle Reports  
Server products (which are licensed separately).  Those products have their own 
Getting Started manual (also included on the CD). 

boldface Boldface indicates user interface items, such as menu choices 
and buttons.

C> C> represents the DOS prompt. Your prompt may differ.

Convention Meaning
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Before You Install

This chapter provides some overview and background information to help you get 
ready for the actual installation and set-up process (described in the subsequent 
chapters).  

1.1 What You Receive
The primary CD in your package contains the following:

■ The Oracle Installer.

■ The software in Forms Developer.  This includes Form Builder itself (all the 
design-time, compile-time, and runtime components), but also the other 
Builders in the Forms Developer family.  The Forms Server component is also 
included, which allows you to deploy applications on the web.   ( Forms Server 
can be used for test purposes, with a restricted license.)

■ A variety of support products:  Oracle Net8 Client, SQL*Plus, Oracle JInitiator,  
Oracle OCX Pack, and Information Navigator.  

■ A number of manuals, in both online and printable format.  (A copy of this 
Getting Started manual is also included.)

■ The online help (accessible both as a separate file and via the Builders), and the 
Quick Tour and Cue Cards.

■ The Release Notes document, which contains important last-minute 
information.
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Hardware and Software Requirements
There is a second CD in the package; it holds the product demos.  The demos are 
installed automatically when the CD is inserted.  That installation process also 
produces a configuration notes file that describes the demos.

1.2 Hardware and Software Requirements

1.2.1 For Forms Developer Itself

1.2.1.1 Hardware
Forms Developer is designed to be installed and run on an IBM  or 100% compatible 
PC with a Pentium  processor or better.  A CD-ROM drive functioning as a logical 
drive is also required for the installation process.   For information on monitor, 
printer, and mouse requirements, see your Microsoft Windows documentation. 

1.2.1.2 Operating System
This version of Forms Developer requires Microsoft Windows.  Specifically, one of 
the following versions:

■ Windows 95 (any version)

■ Windows 98 (any version)

■ Windows NT (Service Pack 5 or later) 

1.2.1.3 RAM for Design Time
128 MB of RAM provides adequate space for for installing and using the 
design/compile portions of the Forms Developer product.  You might find that 
your project works well with less.  

1.2.1.4 RAM for Runtime
The amount of RAM required to run a completed Forms application depends on 
several factors:  the mode in which it will be deployed (web/3-tier or client-server), 
and the size and complexity of the application itself.
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Where to Install: ORACLE_HOME Considerations
1.2.2 Related Software

1.2.2.1 Database Server
Forms Developer is designed to be used with one of the following Oracle database 
servers:

■ Oracle8 (8.0.5 or 8.0.6) 

■ Oracle8i (8.1.5 or 8.1.6) 

Using the server also requires Net8 for Windows.

You can also use Personal Oracle for Windows or Personal Oracle Lite as your 
server.  For the most robust support, however, Oracle8 or 8i is recommended.

You can also use a non-Oracle database server (through ODBC) if it provides 
equivalent function.

1.2.2.2 Web Server
If you are going to deploy your applications to the web (3-tier environment), then 
you also need a web server to act as a listener.

The Oracle WebDB Listener is provided on the Forms Developer CD, and is a 
convenient choice, but any web server can be used.    Both the CGI (Common 
Gateway Interface) style and the cartridge style of listener are supported.

If you choose to use Oracle Application Server as the listener with this release of 
Forms, it must be OAS Release 4.0.8 or later.

1.3 Where to Install:  ORACLE_HOME Considerations
Oracle products are designed to reside in an ORACLE_HOME.

When you install Forms Developer and its related products, you will be asked to 
choose a particular ORACLE_HOME into which the product will be installed.  The 
following considerations apply when you make your choice.

■ Forms Developer 6i must reside in the default ORACLE_HOME.

■ Forms Developer 6i and its Oracle8/8i server must reside in separate ORACLE_
HOMEs, although they can reside on the same physical machine. 
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New Install versus Upgrade
■ Similarly, in a web application deployment, Forms Server and Oracle 
Application Server must reside in separate ORACLE_HOMEs, although they 
can reside on the same physical machine. 

If you intend to not only install this 6i release of Forms Developer, but also retain an 
earlier version of Oracle Developer (as this product was called in earlier releases), 
then you should be aware of the following:

■ Oracle Developer 1.6.1 and Forms Developer 6i can co-exist in the same 
ORACLE_HOME.

■ Oracle Developer 2.1 and Forms Developer 6i can co-exist in the same 
ORACLE_HOME.

■ Oracle Developer 1.6.1 and Oracle Developer 2.1 cannot co-exist in the same 
ORACLE_HOME.

■ Oracle Developer 6.0 and Forms Developer 6i cannot co-exist in the same 
ORACLE_HOME.

 

1.4 New Install versus Upgrade
If you are new to Forms Developer and are installing this product for the first time, 
detailed instructions are provided for you.  Start with Chapter 2.

If you already have a previous version of the product and are upgrading to this 
current version, then the installation process is probably familiar to you.  
Instructions for upgrading start in Chapter 3.   You will also need to consider 
recompiling your existing applications to run with this new version of the product.  
Information on that topic is also supplied in Chapter 3. 

1.5 Deployment on Web or Client/Server?

There are two environments you need to set up:

■ Design-time (which includes the compile step).  This is the environment in 
which the developers will create applications.  This environment includes the 
build and compile components of the Forms Developer product. 
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Check the Release Notes
All the instructions for setting up the design-time environment are included in 
this manual in the following chapters. 

■ Runtime.  This is the environment in which the end users will run the finished 
applications.  This environment includes not just the applications, but also the 
runtime components of the product.

Web Runtime:

Using the web to deploy your applications offers several advantages:  easier, 
centralized maintenance, no storage overhead on client machines, and the 
power of the server.

If you are going to run your applications in a web (that is, 3-tier) environment, 
then you will need to perform additional steps after you finish your 
design-time install.  This primarily concerns installing and tuning the Forms 
Server component in the middle tier.  The instructions for those additional steps 
are provided in several chapters of the manual Oracle Forms Server:  Deploying 
Forms Applications to the Web, A73071.  

Client/Server Runtime:

If you are going to run your applications in a client/server environment, then 
all the instructions you need for setting up that environment are included in 
this manual in the following chapters.

1.6 Check the Release Notes

Before installing any portion of the Forms Developer product, we strongly 
recommend that you read the Release Notes for the most current product 
information.

The Release Notes contain late-breaking information that only became available 
after this Getting Started manual was printed.  The Release Notes may alert you to 
changes in the installation process or the system requirements.  It also lists known 
problems in the product. 

The Release Notes are contained on the product CD.  To obtain the Release Notes, 
perform the following steps:

1. Start the Oracle Installer.

2. In the Installation Options dialog box, choose Custom Installation or Removal.
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Check the Release Notes
3. From the list of available products, select Forms Developer Release Notes.

4. Choose Install.

5. When installation is complete, exit the Oracle Installer.

Once the release notes have been installed from the CD, you can find them in the 
file relnotef in %ORACLE_HOME%\TOOLS\DOC60.   They are available in both txt 
and pdf formats.

You can access the release notes by choosing Start→Oracle Forms Developer 
R6i→Release Notes. 

Once you have checked the release notes to see if there are any last-minute changes, 
you can begin the product installation process.
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Installing as a New Cus
2

Installing as a New Customer

If you do not already have a version of Forms Developer on your system, follow 
these installation instructions.

Remember that you need to install product components both in the design-time 
environment (in which applications will be built) and in the runtime environment 
(in which the finished applications will be used).

  

2.1 Installing the Design-Time Components
Perform the following steps to install the design-time components of Forms 
Developer.  

(Note that installing the design-time components will also install runtime support 
modules, so that your designers can test the applications they build.) 

2.1.1 Step 1: Start the Oracle Installer

The autorun feature 

The Oracle Installer for Windows has an autorun feature that executes setup.exe 
and automatically launches the Oracle Installer when you insert the CD-ROM.  
Most users prefer to install using this automatic feature.

However, if you want to disable the autorun feature, hold down the shift key while 
inserting the CD. 
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Installing the Design-Time Components
Then take the following steps to start the Oracle Installer without autorun. (Note 
that not all CD-ROM drives support the autorun feature.)

To start the Oracle Installer without autorun:

1. Shut down any active Windows applications.

2. Choose Start→Run to display the Run dialog.

3. In the Run dialog box, type the following (where x is the letter of your CD-ROM 
drive):

x:\SETUP.EXE

4. Click OK to start the Oracle Installer.

Choose Installation Settings: Company Name, ORACLE_HOME, and Language 

Before the actual product installation begins, the Oracle Installation Settings dialog 
box is displayed.  In this box:

■ Enter your company name.   

■ The ORACLE_HOME has been pre-set to DEFAULT_HOME.  Keep this default 
setting.

■ In the Language dialog box, select the language in which you wish to run 
Oracle Developer.

Choose the Product

The Installer presents you with a list of product sets on the CD.  Choose Oracle 
Forms Developer.

2.1.2 Step 2: Choose an Install Method

The Oracle Installer will next offer you two choices for setting up the design-time 
environment:

■ Typical Installation

■ Custom Installation
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Installing the Design-Time Components
The simplest and safest choice is Typical Installation.  Selecting this option will 
give you an automatic installation of an appropriate, workable set of the Forms 
Developer components most commonly used.   

After you select Typical Installation on this screen and click OK, the Oracle Installer 
will handle the design-time environment installation process for you.  

As the installation progresses, the installer may prompt you for instructions or 
product locations. We recommend that you accept the default product locations.

A Custom Installation (explained in the next section) is more complex and requires 
greater product knowledge.  Choose this option only if you require this higher level 
of control, and you have a good understanding of the Forms Developer 
components.

2.1.2.1 Custom installation
When you select a custom installation, the Software Asset Manager dialog box is 
displayed.

The products that are available for installation are listed under Products Available. 
The plus sign (+) to the left of a product’s name indicates that this is the name of a 
software package, which consists of a main application and its supporting software. 
You can select the entire package by clicking the line with the plus icon, or you can 
double-click that line to display the pieces of the package, which can be selected 
individually.

The products that are already installed on your machine are listed under Products 
Installed. Some of these may also be software packages, and they behave as 
described in the previous paragraph.

The disk space required for your selection and the disk space currently available on 
your machine are displayed in the Space Required area below the product lists.

The Software Asset Manager dialog box also contains the following buttons:
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Installing the Design-Time Components
Steps for Using the Software Asset Manager to Custom Install:

1.  Select the product or products you want to install in the Products Available list.

As with other Windows-based applications, you can Shift+click to select a series 
of products from the list, or you can Ctrl+click to select multiple, discontinuous 
products.

2. Click Install.

The installation begins. We recommend that you accept the default product 
locations.

3. When installation is complete, each product you have installed is listed in the 
Products Installed list.

4. Exit the Oracle Installer and restart your system.

Button Description

Exit Closes the Software Asset Manager and exits the Oracle 
Installer.

Options . . . Allows you to do the following:

■ Request confirmations before removing or installing 
products

■ Receive detailed messages and prompts during various 
phases of the Oracle Installer’s function

■ Record the Oracle Installer’s actions in a log file

View Log . . . Displays the Event Log. The Event Log displays installation 
and configuration events in the Description Level you choose: 
Summary, Brief, and Detail. You can store and retrieve logs and 
save them to files.

By default, log files are stored in %ORACLE_
HOME%\ORAINST\ORAINST.LOG. If a log file from a previous 
installation exists, it is renamed to ORAINST.OLG.

If you want to keep more than two log files (.LOG and .OLG), 
rename the .OLG file so that it is not overwritten.

Restore Icons Restores Oracle product icons that were deleted.

Help Displays the online Help system.
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Connecting to the Oracle Server
2.2 Installing the Runtime Components

If you are setting up a runtime environment that will operate on the web (or any  
3-tier environment), then  you need to also install the Forms Developer Server 
component.  Instructions for doing so are in the manual Oracle Forms Server:  
Deploying Forms Applications to the Web, A73071.  

On the other hand, if you will be running your applications on client machines in a 
client/server setup, follow the instructions below.

1. Start the Oracle Installer

You start the Oracle Installer in the same way as in Step One above.

2. Choose the Custom Installation Method

When the Installer gives you the choice between Typical and Custom, choose 
Custom.

3. Select the Runtime Component

After you select Custom, the Installer will list all the available components.  
Choose the Runtime component.   

The Installer will then use the Software Asset Manager to install the Forms 
Developer runtime components.

When installation is complete, exit the Oracle Installer and shut down and restart 
Windows. 

2.3 Connecting to the Oracle Server
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Connecting to the Oracle Server
Follow these instructions to install Oracle 8 or 8i on the same physical machine as 
Forms Developer in a Windows NT environment.   Oracle 8 or 8i must be in a 
separate ORACLE_HOME.

The following instructions assume that you have installed Forms Developer in 
DEFAULT_HOME in the ORANT directory on the D drive.

Step One:  Install the Server

Insert the Oracle 8 or 8i product CD and start up the Oracle Installer.

When prompted for the Oracle Home and Full Path, specify the same name.  For 
example, you might specify:

ORACLE_HOME = ora8i

Full Path = d:\orant\ora8i

When asked to choose an install type, choose  "typical."

As the product installs, you are shown a summary indicating the parts installed and 
the space requirements.

When the installation is complete, the following type of information is shown (and 
then the Installer exits):

    Oracle Database Configuration Assistant Alert

   Database Creation Completed.

   Database Information

Global Database Name ora8i.us.oracle.com

         SID                                      ORA8I

        Sys password                     change_on_install

        System passwd                  manager

Step Two:  Connect the TNS Names

Note:  If you do not want to set up the connection manually using the following 
instructions, you can use the SQL*Net Easy Configuration tool (supplied on this 
product CD).  
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Connecting to the Oracle Server
Create a TNSNAMES entry in the tnsnames.ora file.  You can find the file in:

         d:\orant\net80\admin\tnsnames.ora

 A default entry will look like this:

   alias.world =
     (DESCRIPTION =
        (ADDRESS_LIST =
                (ADDRESS =
                        (PROTOCOL = TCP)
                        (Host = )
                           (Port = )
                  )
         )

        (CONNECT_DATA =  (SID =   )
         )
     )

 For example, if you installed on a machine with a HOSTNAME of TEST, a SID 
named ORA8I, on TCP/IP with port 1521, and an alias of NEW, then you would 
create the following entry:

   NEW.world =
      (DESCRIPTION =
            (ADDRESS_LIST =
                    (ADDRESS =
                          (PROTOCOL = TCP)
                          (Host = TEST)
                          (Port = 1521)
                      )
          )
          (CONNECT_DATA = (SID = ORA8I)
          )

      )

If you manually created the entry, save and close the tnsnames.ora file.

The TNS listener must be up and running from the Oracle Server ORACLE_HOME.  

You can now connect from Forms Developer to the local database instance of the 
server using the DBSTRING as NEW.  For example, you can connect as 
scott/tiger@NEW.
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Installing as an Up
3

Installing as an Upgrade

This chapter explains how to install Forms Developer Release 6i when you already 
have a previous release of  the product installed.

(Note that in earlier releases, the product was called Oracle Developer or 
Developer/2000. )

There are two areas to consider:

■ Upgrading the product itself -- that is, installing this new version.

■ Upgrading your old applications -- that is, recompiling them with this new 
version of the product.

3.1 Upgrading the Product

Complete Upgrade Recommended:

If you are upgrading from a previous release of this product (earlier than 6.0), it is 
strongly recommended that you upgrade all of your currently-installed 
components.  This is especially important if you have been using Release 1 or 2.   
Because of improvements to the underlying support files, such as the Tools Utilities, 
GUI Common files, and Required Support Files, the older set of components cannot 
run with the newer set.

(Upgrading from Release 6.0 to this 6i release does not require a full reinstall.)
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Upgrading the Product
Name of the ORACLE_HOME directory:

If you have used previous versions of Oracle Developer on Microsoft Windows 3.x, 
your ORACLE_HOME directory was called ORAWIN.  When you upgraded your 
operating system to Windows 95, 98, or NT, your old ORAWIN directory was 
retained. 

The installation of Forms Developer Release 6i creates a new ORACLE_HOME 
directory. This new directory is named either ORAWIN95 (on Windows 95), 
ORAWIN98 (on Windows 98),  or ORANT (on Windows NT). In any case, your old 
ORAWIN directory is not used or overwritten.

CAUTION:  Do not install or build the Oracle Developer database tables until you 
run the appropriate upgrade script.  If you have customized your product resource 
(.RES) files (e.g., fmrusw.res), you should back these up files before upgrading.

To Upgrade:

Use the Oracle Installer to install the new version of the product from the CD.  If 
you are not familiar with this tool or the options, follow the instructions in the 
previous chapter.  (For this release, the Installer uses new options.)

Remember that if you are going to deploy applications to the web, you should also 
install/upgrade the new version of the Forms Server, as well.

Server Considerations:

Both the CGI (Common Gateway Interface) style and the cartridge style of listener 
are supported in Forms Developer Release 6i.  

The Oracle WebDB Listener is provided on the Forms Developer CD, and is a 
convenient choice, but any web server can be used.

If you are currently using Developer Release 6.0 and Oracle Application Server 
(OAS) Release 4.0.7, and you want to continue using OAS with Forms Release 6i, 
then you need to also install OAS Release 4.0.8.   Be aware of the following 
considerations:
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Upgrading Your Applications
■ You must install OAS 4.0.8 into a separate ORACLE_HOME from Forms 
Developer 6i.

■ You must install OAS 4.0.8 into a separate ORACLE_HOME from OAS 4.0.7.  
Do not overlay or deinstall 4.0.7. 

There also are likely to be additional cartridge upgrade requirements if you install 
OAS 4.0.8.  See the Forms Developer Release Notes for the latest information.

3.2 Upgrading Your Applications

If you want to run your old applications (applications that were created with a 
version prior to Release 6) on this new version of the product, those applications 
need to be recompiled after you have the new product version installed.  

When upgrading applications, please keep the following in mind:

■ We strongly recommend that you make a backup of all modules before 
beginning the conversion process.

■ In general, applications are upwards compatible.  However, there are 
occasionally minor differences in functionality.  

See the sections New Features and Compatibility with Previous Releases in the 
online help for specifics.   Additional compatibility information can be found on 
these websites:

■ http://www.oracle.com/tools/InternetDevTools/

■ http://technet.oracle.com/products/developer/

Some of the functionality differences between releases can be controlled with 
the Forms runtime compatibility option.  Using that option is explained in the 
online help. 

■ Applications that were built with Release 1, 2, or 3 of Forms Developer cannot 
be moved directly to this 6i release for recompile.  Instead, you must first 
recompile them with Release 4.0, 4.5, or 5.0.  After that intermediate conversion, 
you can then recompile them again on this release.

■ Forms Developer Release 6i includes a PL/SQL conversion utility for 
converting modules based on PL/SQL version 1 or 2 to PL/SQL version 8, 
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Upgrading Your Applications
which is the version this release is based on. If you are upgrading from a release 
prior to Developer Release 2.0, you will need to convert all modules (Forms, 
Reports, Graphics, and PL/SQL libraries) to the newer version of PL/SQL. The 
conversion utility runs automatically whenever you open a module containing 
PL/SQL version 1 or 2, allowing you to interactively perform the conversion. 
The conversion can also be run automatically in batch mode. 

See the online help in the Builders for more detailed information on the 
PL/SQL conversion utility.

■ If you are upgrading applications that contain user exits and user-created DLLs, 
those DLL files may need to be recompiled after recompiling your applications 
with the new release.

Applications that make calls through the Forms Developer foreign function 
interface (ORA_FFI package) to 16-bit DLLs will not work under Windows due 
to an operating system incompatibility between 16-bit code and 32-bit 
executables.  The DLL must be recompiled/linked as a 32-bit DLL.

■ Applications that use VBX controls do not run properly under Windows 
95/98/NT due to an operating system incompatibility between 16-bit VBX 
controls and 32-bit executables.  OCX/ActiveX controls are the equivalent for a 
32-bit environment.

3.2.1 Redeploying Your Applications on the Web

After you recompile your older applications with this release, they are eligible to be 
deployed on the web.

For instructions, consult the manual Oracle Forms Server:  Deploying Forms 
Application to the Web, A73071.  Information can also be found in the white paper 
Migrating SQL* Forms Applications to Internet Computing, available on the website   
http://technet.oracle.com/products/developer/.
3-4



If You Have to De
4

If You Have to Deinstall

4.1 Removing the Forms Developer Product

If at any time you need to back out or remove Forms Developer from your system, 
it is strongly recommended that you use the Oracle Installer for that deinstall task.  

The Oracle Installer is specifically designed to both install and deinstall Oracle 
products.  When deinstalling, it is important to remove all components and related 
items.  The Oracle Installer will automatically do this for you.  

If for some reason you are not able to use the Oracle Installer to do the de-install, 
then you need to be sure to also remove all the registry entries related to the 
services created during the installation of Forms Developer, and to remove 
ORACLE_HOME and ORACLE registry keys.   (You can use the registry editor 
provided with Windows for this task.)

To remove Forms Developer from your system:

1. If you are running on NT, stop the NT services that were created during 
product installation as part of Service Side Include.  In addition, if you have 
created any similar services yourself during installation, you must also stop 
those services.

2. Start the Oracle Installer from your Oracle product media or file system.  See  
Chapter 2 for instructions on starting the Oracle Installer.

3. In the Installation Options dialog, select Custom Installation or Removal.

4. Select the product you want to remove from those listed in the Products 
Installed window.
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5. Click Remove. If the products you select to deinstall affect other products, 
Oracle Developer displays a confirmation prompt before de-installing.

NOTE: If you are not using the standard Windows application to control your 
desktop (you are using Central Point PC Tools or Norton Desktop, for example), the 
Oracle Installer may not remove program items correctly.  

If you are going to reinstall  Forms Developer after the deinstall, you will first need 
to reboot the machine.   
4-2



Setting Up Tables to Store Applic
5

Setting Up Tables to Store Applications

You or your database administrator can set up tables in the database that will allow 
application modules to be saved to the Oracle Server. 

For Form Builder, and most of the other Builders, this is an optional step; 
applications do not need to be saved in the server.  However, for Translation Builder 
and Schema Builder, these database tables are a requirement.

If they have the option, most customers choose to not store their applications in the 
server, and they skip this step.  Those who do choose to store applications in the 
server usually do so for the benefits of centralized administrative control.

The following topics are included in this chapter:

■ Building the Database Tables

■ Proper Use of these Tables

■ Granting and Revoking User Access

■ Deleting the Database Tables

■ Upgrading the Database Tables

Creating database tables may require administrator privileges.  Consult with your 
database adminstrator if such authorization is required. 

5.1 Building the Database Tables
WARNING: These instructions are for new installations only. If you already have 
database tables installed for a previous version of an Oracle Developer product, be 
aware that removing the existing tables or attempting to install the database tables 
for the current version of Forms Developer will destroy any Oracle Developer 
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module currently stored in the database. Please see Section 5.5, "Upgrading the 
Database Tables" on page 5-5 for instructions on upgrading existing database tables.

When you create applications with Forms Developer, you can either save your 
modules as files or save them to the server. Saving modules to the server conserves 
disk space on client machines and allows shared access to the modules, although 
access to modules stored on the server can be slower than when they are stored as 
files on the client machine. You may wish to consider the following information 
when deciding where to store your modules.

Before users can save modules to the server, a system administrator must build 
tables to accommodate the modules and grant access privileges to users who will 
work with those tables. 

5.1.1 Step 1: Installing the SQL scripts with the Oracle Installer
If you have not already done so, use the Oracle Installer to install the SQL scripts 
needed to build and administer the Forms Developer database tables.

To install the SQL scripts:

1. Start the Oracle Installer and select Custom Installation or Removal from the 
Forms Developer Installation Options dialog box. (Refer to Chapter 1 for more 
information on the Oracle Installer.)

2. Select Forms Developer Database Tables from the Available Products list.

3. Click Install.

Installing these scripts creates a Start menu item called Forms Developer R6i 
Admin and the associated submenu items Forms Developer Build, Drop,  Grant, 
and Revoke. These menu items, when selected, run a script or a series of scripts to 
perform database administration tasks.

Storage Location When to Use

Database server When you want security that is not provided by your operating 
system.

When you want to store applications on the client machine, but 
you do not have enough disk space.

When you want to share applications with other users.

When module access speed is not as important as the 
considerations listed above.

File system When the above criteria are not true or not important.
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5.1.2 Step 2: Building the Oracle Developer database tables
To build the Oracle Developer database tables:

■ Click Start→Programs→Forms Developer R6i Admin→Forms Developer 
Build.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVBILD.SQL

5.2 Proper Use of these Tables
Form Builder and the other Builders use the database tables for storing modules. 
The database tables are not intended for any other use. The structure and 
organization of the tables are likely to change from release to release.  We strongly 
recommend that you do not try to use SQL queries against the tables to produce 
reports or documentation about your modules. Use of the tables in this way is not 
supported by Oracle. For this reason, the structure and content of the tables are not 
provided.

5.3 Granting and Revoking User Access
After building the Form Developer database tables, you must grant user access to 
the tables. If you wish to withdraw access from a user, you must revoke it. Both of 
these tasks are accomplished with SQL scripts provided through the Oracle 
Installer.

For more information about database roles, see the Oracle8/8i documentation.

5.3.1 Granting access to the database tables 
You must perform this task for each user who requires access to the tables. 
Alternatively, you can grant access to all users simultaneously by granting access 
for user PUBLIC. 

To grant access to the Forms Developer database tables:

1. Click Start→Programs→Forms Developer R6i Admin→Forms Developer 
Grant. You will be prompted to enter a username.

2. Enter the username of a user to whom you will grant access to the tables.

To grant access to all users, enter PUBLIC and skip step 3.
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3. Repeat steps 1 and 2 for each user to whom you want to grant access.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVGRNT.SQL username

5.3.2 Revoking access to the database tables 
You must perform this task for each user whose access to the tables you want to 
revoke. Alternatively, you can revoke access for all users simultaneously by 
revoking access for user PUBLIC. 

To revoke access to the Forms Developer database tables:

1. Click Start→Programs→Forms Developer R6i Admin→Forms Developer 
Revoke. You will be prompted to enter a username.

2. Enter the username of the user whose access you wish to revoke.

To revoke access from all users, enter PUBLIC and skip step 3.

3. Repeat steps 1 and 2 for all users whose access you wish to revoke.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVRVKE.SQL username

5.4 Deleting the Database Tables
WARNING: Deleting the database tables erases any module stored in those tables. 
Do not delete database tables until you have verified that you do not need any 
module currently stored in the table or tables you intend to delete. See 
Section 5.5.0.1 for more information on backing up modules currently stored in your 
database.

To delete the Forms Developer database tables:

■ Click Start→Programs→Forms Developer R6i Admin→Forms Developer 
Drop.

This menu item runs the following SQL script:

%ORACLE_HOME%\TOOLS\DBTAB60\DEVDRP.SQL
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5.5 Upgrading the Database Tables
If you are upgrading from Release 1 to Release 6i of Oracle Forms Developer, the 
only database tables that need upgrading are those for Translation Builder.   Tables 
for the other Builders (Form Builder, Graphics Builder, Procedure Builder, Query 
Builder, and Schema Builder), and the common tables, do not need to be upgraded. 

You can run one or more upgrade scripts instead of creating the tables from scratch. 
Doing so updates the administration information in your existing tables. 

5.5.0.1 Step 1: Back up the database contents
If you have any modules stored in the database that you wish to continue using 
after you upgrade the database tables, you will need to back up these modules. Any 
modules that you do not back up will be lost.

Before you back up existing modules, it might be useful to have a list of all available 
modules currently stored in the database. To do this, log on to the database and run 
the following SQL script:

column product format a15
column modtype format a15
SELECT product, modtype, owner, modname
FROM tool_module
ORDER BY product, modtype, owner;

You can recognize the source files for application modules by their file extensions:

■ Form Builder: .FMB, .MMB, and .PLL files

■ Graphics Builder: .OGD files

■ Procedure Builder: .PLL files

■ Query Builder: .BRW and .SQL files

To back up a module:

1. Open the module in the appropriate Builder.

2. Save the module as an operating system file using the File→Save As command.
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5.5.0.2 Step 2: Upgrade the tables
Once you have backed up the database, you can upgrade the Translation Builder 
database tables.

Note: Run all SQL scripts under the SYSTEM account.

Upgrade the existing tables by running the following script:

%ORACLE_HOME%\TOOLS\DBTAB60\OTM60\SQLMIG.SQL

5.5.0.3 Step 3: Restore the database contents
Once you have completed upgrading the database tables, you can restore the 
modules to the database.

To restore a module:

1. Open the module in the appropriate Builder.

2. Save the module as a database module using the File→Save As command.

5.5.0.4 Step 4: Grant user access again 

After you’ve upgraded from a previous version, you must once again grant user 
access to the database tables. See Section 5.3 for information about how to do this.
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What’s Next?

You’ve completed the installation of the Forms Developer product.  What’s the next 
step?

6.0.1 If You’re a New Forms Developer

Start familiarizing yourself with the features of this product, and learning how to 
create forms applications.

A good place to begin is with the Quick Tour.  This is included with the product CD, 
and has now been installed and made available.  (To access the Quick Tour, start 
Form Builder, and on its Welcome screen, choose the option Run the Quick Tour.  
You can also start the Quick Tour from the Help menu on any of the Builders.)

After completing the Quick Tour, move on to the detailed documentation in the 
manuals and the online help topics.

You may also wish to install and examine the product demos (supplied on a 
separate CD in your package).  They offer another good source for learning about 
the product.

Supplementary information is occasionally created for users of this product.  You 
can access this material (white papers, for example) on the Oracle Developer web-
sites at   http://www.oracle.com/tools/InternetDevTools/ and  http://technet.ora-
cle.com/products/developer/.

6.0.2 If You’re an Experienced Forms Developer
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Look at the What’s New section in the online help.  This offers a quick summary of 
new functionality in this release.   There is also a What’s New section in the Quick 
Tour.  

Also look at the Compatibility with Previous Releases section in the online help.  This 
provides an overview of behavior that has changed.

For details about a particular new feature or behavior, see the specific help topics 
and/or sections in the manuals.

A new manual is available with this release:  Oracle Forms Server:  Deploying Forms 
Applications to the Web, A73071.   This manual can help you understand the benefits 
of web deployment, and the steps to take to accomplish that.

It is also useful to occasionally check the Oracle Developer websites at     
http://www.oracle.com/tools/InternetDevTools/  and  http://technet.ora-
cle.com/products/developer/.  Helpful supplementary information is posted there.  
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